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Every effort has been made to ensure that the material herein is complete and accurate. However, the
manufacturer is not responsible for any mistakes in printing or faulty instructions contained in this book.
Notification of any errors or misprints will be received with appreciation.

For further information regarding a particular Software, contact the manufacturer or your local
representative or distributor.
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Chapter 1 Introduction Creating a New Site

Chapter1  Introduction

1.1.1 Installation

For information about PAS installation see the document “PAS Installation Guide”.

1.1.2 File Format

PAS use the Microsoft Access .mdb database format for setup and log files. This format allows you to
store different types of logs to a single database as separate tables, and makes it easy to transport your
databases onto other PCs.

1.1.3 Data Retrieving from the Meters

PAS allows you to retrieve all data logs from your meters at once and store them to a database, either on
demand or on a time basis (e.g., daily or weekly) using a predefined schedule.

1.1.4 Embedded Communication Test

PAS incorporates the test features allowing you to test communication with your meters.

1.1.5 General Note

This manual includes the most common PAS features and options that are used for working with SATEC
meters. For additional and more detailed information about PAS working with some specific meter see the
manual of corresponded meter.
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Chapter 2 Communicating with Your Meters Creating a New Site

Chapter2  Communicating with Your Meters

2.1 Creating a New Site

In order to communicate with your meters, you should create a separate site database for each one where
all meter settings are stored. PAS keeps all site settings in a file with a name you give it and the extension
.mdb. When you install PAS on your computer, a directory named "Sites" is created in the PAS installation
directory. It is advised to keep all your site databases in this directory.

To create a new database for your meter, select 'Configuration' from the Tools menu, and then click 'Sites'
at right on the 'Instrument Setup' tab.
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From the 'Look in' box, select the directory where a new database will be stored. Type a site name for your
meter in the 'File name' box, click 'New', and then click 'OK'. You will see the selected site's name in the
'Site’ box. As you create new databases, their names are added to the site list that you can browse from

this box.
Laok ir: I@ Sites x| &= ek B
BFM EM720_204 PIM130 PM175 ‘
DefaultSite EM72Z0_GPRS [ PM130_al PM175_5C ‘
= em130 = Emazo [ pr13s = pr1a0 =)

EM133 EM920_GPRS PM17z2 PIMZ05
EM133_new ETC2002 PM174 RiGM
EM133-R B2PAC PM174_L RGM180

L |

File name: — [PH150 0l

e

Filez of type:

Comment: Duplicate

ElEl .

Cancel

In the 'Model' box, select your meter model type, and in the 'Instrument Options' group boxes,
specify the voltage and current input and analog output (if any) options for your meter. If the
meter has an onboard logging memory, select the correct memory module size for your meter.

You can add any comments to the ‘Comments' box, such as meter location or any other data concerning
this particular site.
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Chapter 2 Communicating with Your Meters Setting up Communications

Note: You cannot change the site properties or communication settings when the 'On-line' button @ on
the toolbar is checked. Uncheck it before entering the 'Configuration' dialogs.

2.2 Setting up Communications

You can communicate with your devices via a PC RS-232 serial port, through the Internet, via either a
local Ethernet, or CELLULAR modem, and via the USB port.

To configure your communications:

1. Select Configuration from the Tools menu.
Under the Communication group on the
Instrument Setup tab, select the type of a
connection for your device.

2. Set the device communication address you
assigned to the meter. When communicating via
the Ethernet or a CELLULAR modem, the meter
responds to any address you select.

3. In the “Sampling Rate” box, select a rate at
which PAS updates data on the screen when
polling the device via the PAS Data Monitor.

The communication protocol and port settings must match the settings made in your device.

2.2.1 Communicating through a Serial Port

On the 'Connection' tab, select from the 'Device' box a COM port and click on 'Configure' to specify the
baud rate and data format for the port. Choose the same baud rate and data format as you have set in the
meter, and then click 'OK'.

Select Serial Port/Modem Site on the Configuration tab, and then click on the Connection tab to
configure your serial port settings.

Selecting the Communications Protocol
1. On the Connection tab, click Protocol.

Protocol Setup |

Response Timneouk: Im 3: [ms]

Ereak Timeout: | 20 =1 [ms]
Retries[1...5 I 1 3:

Transmission Delay: I a 3: [ms=]
Pratocoal: IMDdbus RTU "I

oK I Cancel |

2. In the “Protocol” box, select the same
communications protocol as you have in your
device.

3. The remaining settings in this dialog do not
normally need to be changed.

4. In the “Response Time-out” box, define the
maximum time that PAS should wait for the
meter response before announcing a failure.
When communicating through a CELLULAR
modem, this time may require some adjustment.
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Chapter 2 Communicating with Your Meters Setting up Communications

5. The “Break Time-out” box defines the maximum
idle time that PAS waits after receiving the last
message character to close a connection. This
setting is important only when PAS is running the
Modbus RTU or DNP3 or IEC 60870-5 protocols.
It does not affect Modbus ASCII
communications. The default value of 10 ms is
usually sufficient for reliable communications,
but the load on your PC can affect it. If there are
many applications running on your PC, PAS
might be prevented from responding to received
characters fast enough, so it may close the
communication while the device is still
transmitting a message. If you frequently receive
the message “Communication failed”, this could
mean that “Break Time-out” should be
increased. This time is added to the message
transfer time, however, increasing it excessively
slows down communications.

6. The “Retries” box defines the number of
attempts that PAS uses to receive a response
from the device in the event the communication
fails before announcing a communication failure.

Configuring a Serial Port

1. On the Connection tab, select a COM port from
the “Device” box, and then click Configure.

Serial Port Setup - x|

Baud Rate: |kl

Data Bits: IE "I
Stop Biks: |1 vl
Parity:INo Parity "I

o4 I Zancel |

2. Specify the baud rate and data format for the
port. Choose the same baud rate and data
format as you have set in the device, and then
click OK.

2.2.2 Communicating through a Modem

Selecting the Communications Protocol

On the Connection tab, click Protocol, and then select the protocol settings as shown above for a
serial port.

Configuring a Modem

1. On the Connection tab, select from the “Device”
box a local modem installed on your PC through
which you communicate with your device.

2. Click on Phones to add the phone number of the
remote device to the phone list.

3. Type the phone number in the “Phone number”
box, add comments if you desire, click Add, and
then click OK.
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Chapter 2 Communicating with Your Meters

Setting up Communications

4., From the “Phone number’” box on the
Connection tab, select the phone number from

the list, and then click OK.

2.2.3 Communicating through Internet

1. Click on the Connection tab.

2. Click on the “IP address” and type in the IP
address of the meter.

3. Inthe “Protocol” box, select the communications

protocol for the TCP port. PAS automatically
adjusts the TCP port number in the “Host Port”
box, corresponding to the selected protocol. Use
the following references to check the TCP port
setting:

502 - Modbus RTU

20000 - DNP3.0

2404- |IEC 60870-5

5002 — Modbus ASCII or SATEC ASCII
emirnien

bnairurmand Sk Convachian |

e
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|
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1o 8. a4 AN Bﬂ-llll-ﬂm ™ Badalial
i ETE- B ] ey | | =

; o I I |

I 2 I | |

[ ] ces | dowe | Hew |

You can also adjust the amount of time that PAS
waits for a connection before announcing an
error and the number of retries PAS uses to
receive a response from the device if
communications fail.

2.2.4 Communicating through a CELLULAR Modem

For information how to setup communication through CELLULAR modem
see the manual of corresponded meter.

2.2.5 Communicating through a USB
On the Instrument Setup tab, click USB Port, and then click OK.

Power Analysis Software_Getting Started



Chapter 3 Setting Up the Device Creating Setups for your Meters Off-
Line

Chapter3  Setting Up the Device
3.1 Creating Setups for your Meters Off-Line

PAS allows you to prepare setup data for your device off-line without the need to have it connected to your
PC.

Select the device site from the list box on the PAS toolbar, and then select the desired setup group from
the Meter Setup menu. Click on the tab with the setup you want to create or modify and fill in the boxes
with the desired configuration data for your device. Click the “Save as...” button to store the data to the
site database.

Note: PAS uses the Basic Setup data as a reference in all setup dialogs. Create the Basic Setup
configuration for your meter first and save it to the site database before preparing other meter setups.

To reuse setups from another site, you can simply copy them to your present site database. Click Open,
select the desired site database, and then click OK. The opened setup is copied to your site database.

You can also copy all setups from one site database into another site's database. Select a device site from
the list box on the toolbar from which you want to reproduce setups, and then select “Copy to...” from the
Meter Setup menu. Select the site database to which to copy setups, and then click OK.

3.2 Downloading Setups to Your Meters

PAS allows you to update each setup in your meter one at time or to download all setups together from
the site database.

To update a particular setup in your meter, check the 'On-line' button @ on the toolbar, select a meter
site from the list box on the toolbar, and then select the desired setup group from the 'Meter Setup' menu.
Click on the pane with the name of the setup you want to download to the meter, and then click 'Send'.

To download all setups to your meter at once, check the 'On-line' button Eﬁ on the toolbar, select a
meter site from the list box on the toolbar, and then select 'Download Setups' from the 'Meter Setup' menu.
Reply 'Yes' to the PAS warning message.

ploading Setups from Your Meters

PAS allows you to update the site databases with the setups currently presented in your meters.

To upload the setups from the meter to the site database, check the 'On-line' button @ on the toolbar,
select a meter site from the list box on the toolbar, and then select 'Upload Setups' from the 'Meter Setup
menu. Reply 'Yes' to the PAS warning message.
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Chapter 4 Device Control Authorization

Chapter4  Device Control

This chapter describes how to change device modes, view and clear device diagnostics, and directly operate relay
outputs in your meter from PAS. To access device control options you should have your device online.

4.1 Authorization

If your device is password protected, you are prompted for the password when you send your first command to the
device.

Authorization Required _ x|

Paszwoard: |0 =i

Cancel

Enter the password and click OK. If your authorization was successful, you are not prompted for the password again
until you close the dialog window.

4.2 Remote Relay Control

From PAS, you can send a command to any relay in your device or release a latched relay, except of the relays
that are linked to the internal pulse source. Such relays cannot be operated outside of the device.

To enter the Remote Relay Control dialog, check the On-line &ﬁ' button on the PAS toolbar, select Device Control
from the Monitor menu, and then click on the Remote Relay Control tab.

PM180_USB - Device Control 5[

Remate Relay Control | Ewent Flagsl Device Diagnosticsl Eommunicationsl

Relay Relay Remotelocal Blocking Remote:
o, Status Latch Command
1 CLOSED 1] 1] MHOHE -
2 OPEN O O MONE = &l
3 CPEM MO MO MOME | Frint |
4 OPEN MO MO MONE -
= Send |
5 CPEM MO MO MOME -
G CPEM MO MO MOME hd Receive |
T CPEM MO MO MOME hd
g OPEN MO MO MONE hd
g

QK I Cancel Apply Help

To send a remote command to the relay:

1. From the “Relay Command” box for the relay,
select the desired command.

2. Click on Send.

The dialog shows you the present relay status and whether it is latched by a remote command or locally from the
setpoints.

Power Analysis Software_Getting Started 11



Chapter 4 Device Control Device Event Flags

4.3 Device Event Flags

Some meters can have event flags that are intended for use as temporary event storage and can be tested and
operated from the control setpoints. You can transfer an event to the setpoints and trigger its operation remotely by
changing the event status through PAS.

To enter the Event Flags dialog, check the On-line button on the PAS toolbar, select Device Control from the Monitor
menu, and then click on the Event Flags tab.

EELETITTT———— o
ity Mstay Cornal Dvand Py | D Disgrarics | Commurc s |

- _ o |
I L o |
i | oaRF
| lh!irlll
o |
[ e

To change the status of an event flag:

1. From the “Status” box for the event flag, select
the desired flag status.

2. Click on Send.

4.4 \Viewing and Clearing Device Diagnostics

You can examine the present device diagnostics status and clear it via PAS.

To enter the Device Diagnostics dialog, check the On-line &ﬁ' button on the PAS toolbar, select Device Control
from the Monitor menu, and then click on the Device Diagnostics tab.
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Chapter 4 Device Control Updating the Clock

PM180_USE - Device Control il

Femate Felay Contral | Event Flagz Device Diagnastics | Communications |

Dewice Diagnostics !
Device Fault Status

Critical Error

Permanent Fault (critical)
RAMData Fault

HW YWiatchdog Reset
DEPiSampling Fault

CPU Exception

Fun-time Error

S Wiatchodog Reset
Power Down

Clear |

Receive |

Device Reset

Configurstion Reset

RTC Fault (critical)
Configuration Fault (critical)
Battery Low

Expanded Memary Fault
CPU EEPRCM Fault

o o o o o o

A

ak I Cancel I Apply | Help

To clear the device diagnostics events, click on Clear.

More details about device diagnostics see in the manual of corresponded meter.

4.5 Updating the Clock

To update the Real-Time Clock (RTC) in your device, select a device site from the list box on the toolbar, check the
On-line button &ﬁ' on the PAS toolbar, and then select RTC from the Monitor menu.

The RTC dialog displays the current PC time and the time in your device. To synchronize the device clock with the
PC clock, click Set. You need not update the clock in your device if the clock is synchronized to the external GPS

master clock.
PM180_USB - Real Time Clock x|

P Hime: |13:24:14 1042512 THU Read

Device time: |13:24:14 10/25{12 THU Set

e

Close
Conkinuous Stop |

4.6 Resetting Accumulators and Clearing Log Files

PAS allows you to clear energy accumulators, maximum demands, Min/Max log registers, counters and log files in
your device. To open the Reset dialog, select a device site from the list box on the toolbar, check the On-line button

99 on the toolbar, and then select Reset from the Monitor menu.
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Chapter 4 Device Control Upgrading Meter Firmware

Reset - PM180_USE

Reset |

| Reset Energy I

Reset Max, Demands

Reset Billing/TOU Energy

Reset Billing/TOU Max, Demands

Reset Counters

Clear MinfMax Log

Clear Event Log

Clear Data Log

Clear Wavefarm Log

Clear SOE Log

Clear P Log

Clear Fault Log

Clear all Log Files

Clear Operation/Event Counters

QK | Cancel | Apply | Help |

To reset the desired accumulation registers or to clear a file, click on the corresponding button. If a target has more
than one component, you are allowed to select components to reset. Check the corresponding boxes, and then
click OK.

4.7 Upgrading Meter Firmware

You can upgrade device firmware through any communication port installed in your meter: a serial port, USB,
Ethernet, a wireless cellular network or a telephone modem.

Downloading firmware is only supported through the Modbus RTU/ASCII and Modbus/TCP protocols (more exactly
see in manual of corresponded meter). If you are connected to the meter via a serial port, ensure that it operates in
Modbus mode. It is also recommended to set the serial port baud rate to 115,200 bps.

To download a firmware file to your meter:

1. Check the On-line button on the PAS toolbar,
select Flash Downloader from the Monitor menu,
and then confirm changes.
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Chapter 4 Device Control Upgrading Meter Firmware
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2. Point to the firmware upgrade file, click Open, and then confirm upgrading the
meter.

3.  When asked for the password, type the meter password, and click OK.

PM180 - RALAMAINGWITK I Download\PM18... - X

Downloading file...
ENNNNNNEN

20.3% done 00h 00m 195 left

4. Wait until PAS completes downloading the file. It takes about 9-10 minutes at
115,200 bps via a serial port, or about 20 seconds via a USB port, to download
the file to the meter.

PR30 - RALAMAINYYITX I Download PM18... — *

Download is complete

5.  Wait about 10 seconds until the meter completes burning firmware into the flash
and reboots before any further manipulating with the meter.

NOTES

1. When the meter reboots, the Internet connection
via the Ethernet, a telephone or a cellular
network may be temporarily lost. You may need
to wait a short duration before PAS restores a
connection with your meter.

2. If you are connected to the meter via a wireless
cellular network using a temporary IP address,
the IP address you used for connecting to the
meter will no longer be in effect. You should
check the meter for a new IP address either from
the front display, or via PAS using another
communication port.
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Chapter5  Monitoring Your Meters

Real-time data is continuously retrieved from your devices and updated on the screen at the rate you defined in the
Instrument Setup.

To get real-time data from your device, select the device site from the list box on the PAS toolbar, point to RT Data
Monitor on the Monitor menu, and then select a data set you want to view.

5.1.1 Organizing Data Sets

PAS supports 33 programmable data sets with up to 40 data parameters. Set #0 is intended for simple meters,
which have a limited number of parameters, and is not recommended for the use with the meter. To re-organize

data sets, select Data Set from the Monitor menu or click on the button on the local toolbar.
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Some data sets are preset for your convenience and others are empty. You can freely modify data sets.
5.1.2 Polling Devices

To run data polling, check the On-line button @ on the PAS toolbar, and then click on either the Poll button H'

W

You can open as many data monitor windows as you wish, either for different sites, or for the same site using
different data sets.

or Continuous Poll button on the local toolbar. Click on the Stop button B to stop continuous polling,

An open data monitor window is linked to the current site and does not change if you select another site in the site
list.

You can view acquired data in a tabular form or in a graphical form as a data trend.

The following picture shows a typical data monitor window.
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Polling Options
To change the polling options, click on the Data Monitor window with the right mouse button and select Options.
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If you check “Do not stop on errors”, polling is resumed automatically when a communication error occurs, otherwise
polling stops until you restart it manually.

5.1.3 Viewing a Data Table

Changing the Data View

PAS displays data in either a single record or multi-record view. To change the view, click on the Data Monitor
window with the right mouse button and select either Wrap to see a single record, or UnWrap to go to the multi-
record view.

Adjusting the Number of Rows in a Multi-Record View

Click the window with the right mouse button, select Options, adjust the number of records you want to see in the
window, and then click OK. When the number of retrieved records exceeds the number of rows in the window, the
window scrolls up so that older records are erased.

Selecting Primary and Secondary Units

Voltages and currents can be displayed in primary or secondary units. To select primary or secondary units for your
data views, click on the monitor window with the right mouse button, select Options, select the desired units for
voltages and currents, and then click OK.
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5.1.4 Viewing Data Trend

To view a data trend, click on the IE button on the local toolbar. To change the time range for your graph, click
on the button on the local toolbar, and then select the desired date and time range.
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Selecting Channels

To select data channels for your trend, click on the trend window with the right mouse button, select “Channels”,
check the channels you want displayed, and then click OK.

Customizing Line Colors and Styles

Trend lines for different channels can be shown in different colors using different line styles. To change the colors
or line styles, click on the trend window with the right mouse button, select “Options...”, click on the “Display” tab,
adjust colors and styles for channels, and then click OK. You can also change the colors for the background and
gridlines.

Using the Marker Lines

The trend window has two blue dashed marker lines. The left marker indicates the starting position for calculating
the average and peak values, and the right marker indicates the end position.

To change the marker position, click on the trend window with the right mouse button and select Set Marker, or
click on the 4+ button on the window toolbar, and then click with left mouse button on the point where you want to
put the marker. You can also drag both markers with the mouse, or use the right and left arrow keys on your
keyboard to change the marker position. Click on the trend pane with the mouse before using the keyboard, to allow
the keyboard to get your input.

Delta Measurements

To measure the distance between two trend points, click on the Delta button & on the toolbar, click with the left
mouse button on the first point, and then click on the second point. The first reference point is frozen until you close
and reopen Delta, while the second point can be placed anywhere within the trend line. You can measure a delta
in both directions. To disable Delta, click on the Delta button again.

Using a Zoom
You can use a horizontal and a vertical zoom to change size of your graph. Use the buttons 4 B4 on you local
toolbar representing green arrowheads to zoom in or out of the trend graph. Every click on these buttons gives you

a 100-percent horizontal zoom. Two buttons E’l 'El representing a magnifying glass give you a proportional zoom
in both directions.
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5.1.5 Saving Data to a File

To save retrieved data to a file for later analysis, click on the Save button E selecta directory where you want

your log files to be stored, select a database or type the name for a new database, and then click Save. To avoid
confusion, do not store data files into the “Sites” directory where site databases are located.

5.1.6 Printing Data

To print retrieved data, click the % button on the PAS toolbar, select a printer, and then click OK. To check the
report, as it will look when printed, select Print Preview from the File menu.

5.1.7 Copying Data

To copy the entire data table or a part of a table into the Clipboard or into another application such as Microsoft
Excel or Word:

1. Click on the Data Monitor window with the right
mouse button and choose Select All, or click on
the upper-left corner of the data table (where the
“No.” label is displayed).

2. Click on the Data Monitor window with the right
mouse button again and choose Copy or click on

the Copy button on the PAS toolbar.

3. Run an application to where you want to copy
data, position cursor at the correct place, and

then click on the Paste button EZ on the
application's toolbar, or select Paste from the
Edit menu.

If you want only a part of data to be copied, select with the mouse while holding the left mouse button the rows or
columns in the table you want to copy, and then click on the Copy button on the PAS toolbar.

5.1.8 Real-time Data Logging

PAS allows you to log polled data records to a database automatically at the time it updates the Data Monitor
window on the screen.

To setup the real-time logging options:

1. Open the Data Monitor window.

2. Click on the “RT Logging On/Off” % button on the local toolbar, or select “RT Logging Options” from
the Tools menu.

3. Select a database, or type the name for a new database and select a directory where you want to save
it.

4. Select the number of tables, and the number of records in each table you want recorded.

5. Adjust the file update rate for automatic recording. It must be a multiple of the sampling rate that you
defined in the Instrument Setup dialog.

6. Click Save.

When you run real-time data polling, PAS automatically saves retrieved records to the database at the rate you

specified. The “RT Logging On/Off” button % on the toolbar should be checked all the time to allow PAS to perform
logging. You can suspend logging by un-checking this button, and then resume logging by checking it again.

5.2 Viewing Real-time Min/Max Log

To retrieve the real-time Min/Max log data from your device, select the device site from the list box on the PAS
toolbar, point to RT Min/Max Log on the Monitor menu, and then select a data set you want to view.
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PAS supports nine programmable data sets with up to 40 data parameters in each one. To re-organize data sets,

select Data Set from the Monitor menu or click on the button on the toolbar. You can modify data sets in the
way that is convenient for your use.

To retrieve the selected Min/Max log data, check the On-line button @ on the PAS toolbar, and then click on the
Poll button W .

You can save retrieved data to a file or print it in the same manner as described in the previous section.

5.3 Viewing Real-time Waveforms

To retrieve the real-time waveforms from your device, select the device site from the list box on the toolbar, and
then select RT Waveform Monitor from the Monitor menu.

To retrieve waveforms, check the On-line button Eﬁ on the PAS toolbar, and then click on either the Poll button
B or Continuous poll button W . Click on the Stop button B to stop continuous polling.

PAS normally retrieves eight 4-cycle AC waveforms (V1-V4 and 11-14) sampled at a rate of 128 samples per cycle.
If you wish to get only waveforms for selected phases, select “Options” from the Tools menu, click on the
Preferences tab, check the phases you want polled, and then click OK.

To view Al waveforms, or to change channels displayed in the window, click on the waveform window with the right
mouse button, select “Channels’, check channels you want displayed, and then click OK.

Retrieved waveforms can be displayed in different views as overlapped or non-overlapped waveforms, as RMS
cycle-by-cycle plot, or as a harmonic spectrum chart or table. See par.7.5 for information on using different
waveform views.
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Chapter 6 Retrieving Recording Files

Demand

Uploading Files on

Chapter 6

your PC in the MS Access database format.

Historical data can be uploaded on demand any time you need it, or periodically through the Upload Scheduler that
retrieves data automatically on a predefined schedule, for example, daily, weekly or monthly. If you do not change
the destination database location, the new data is added to the same database so you can store long-term data

Retrieving Recording Files

Using PAS, you can retrieve recorded events, data and waveforms from your devices and save them to files on

profiles in one database regardless of the upload schedule you selected.

6.1 Uploading Files on Demand

To retrieve the log files from your device:

1.

6.

Select a device site from the list box on the PAS
toolbar.

Check the On-line button @ .
Select Upload Logs from the Logs menu.

Select a database

Savein: I I3 Paz

x| = @k E-

Log Files EM720_204

Samples EMaz0

Sites PasConfig

TEMP
Usge
20110329_01

File name:
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Select Logs |

Select a database, or type the name for a new
database, and select a directory where you want
to save it.

Click on the “Select Logs” button and check
boxes for logs you want to be retrieved from the
device.

carcnl |

If you wish to retrieve data starting with a known
date, check the “From” box and select the start
date for retrieving data.
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Scheduler

7. If you wish to retrieve data recorded before a
known date, check the “To” box and select the
last date for retrieving data.

8. Click OK.

6.2 Using the Upload Scheduler

6.2.1 Setting Up the Upload Scheduler

1. Select UpIoad Scheduler from the Logs menu.
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2. Click Add Site, point to the site database for
which you want to organize the schedule, and
then click OK.

3. Click Browse and select a database for storing
retrieved data, or type the name for a new
database, select a directory where you want to
save it, and then click OK.

4. Click Configure or double click on the site row.
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5. Select a daily, weekly or monthly schedule, and
adjust the start time. If you wish to upload data
periodically in predefined intervals, click on
“Periodic” and define the time period in hours
and minutes.

6. Select the number of attempts to upload data in
the event of temporary communication problems
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or unavailability of your device, and the delay
between attempts in minutes and seconds.

7. If you wish to use the schedule to synchronize
the device clock with your PC, check the “RTC
Synchronization Enable” box. If your device is
password protected by a communications
password, type in the password you set in the
device to allow PAS to update the clock.

8. Click on the Select Logs button, check the boxes
for logs you want to upload on a schedule, and
then click OK.

9. Check the Enabled box at left to activate a
schedule for the device.

10. Click OK to store your schedule.

To keep the Upload Scheduler running, the On-line button @ on the PAS toolbar must be checked all the time.
If you uncheck it, the scheduler stops operations. This does not cause loss of data, since the scheduler will resume
operations when you check this button again.

6.2.2 Suspending the Scheduler

To suspend the Upload Scheduler, check the Suspend Scheduler box at right. To activate the Upload Scheduler,
leave this box unchecked.

6.2.3 Running the Scheduler on Demand
You can run the scheduler at any time outside the schedule by checking the Start Now box at right. This is a one-
time action. After uploading is completed, the Upload Scheduler un-checks this box automatically.

6.2.4 Reviewing Upload Problems

When the Upload Scheduler fails to retrieve data from the device, or some data is missing, or another problem
occurs, it puts an error message to the log file. To review this file, select System Log from the View menu.

6.3 Retrieving EN50160 Statistics Files

The EN50160 statistics files and present contents of the EN50160 evaluation counters can be retrieved by PAS
and stored to a database for later analysis.

6.3.1 Using the Upload Scheduler

The PAS Upload Scheduler automatically retrieves the EN50160 statistics files on a daily or weekly basis depending
on the EN50160 evaluation period selected in your device.

Select the Daily or Weekly schedule for the EN50160 statistics files when configuring the upload schedule. Check
the Data log #9 and #10 boxes in the Select Logs dialog box for uploading the EN50160 Compliance Statistics and
EN50160 Harmonics Survey files respectively.

6.3.2 Retrieving EN50160 Statistics Files on Demand

To manually retrieve the EN50160 statistics files on demand, select “Upload EN50160 Compliance Stats” from the
Logs menu and specify the database to which you want the data to be stored.

6.3.3 Retrieving the EN50160 Online Statistics

To retrieve the present contents of the EN50160 statistics counters accumulated since the beginning of the current
evaluation period, select “Upload EN50160 Online Stats” from the Logs menu and specify the database to which
you want the data to be stored. The statistics records are marked as online events.
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6.4 \Viewing Historical Data On-line

Sometimes, it is useful to review a particular piece of historical data on-line at the time you expect new events to
appear in the log. PAS allows you to retrieve historical data from a particular log without storing it to a file. The data
appears only in the window on your screen. You can save it manually to the database.

To view the log data on-line, check the On-line button &ﬁ' on the PAS toolbar, select the log you want to retrieve
in the Logs menu, and then click on the Poll button W Only new log records are retrieved from the device. If you
want to review the entire log from the beginning, click on the Restore log button ¥, and then click on the Poll
button I .

Notice that there is a difference between retrieving waveforms on-line and viewing waveforms from a file. The online

waveforms are read one record a time, so that a multi-record waveform series may not be viewed as a single
waveform.

See Chapter 7 Viewing Log Files for information on using different log views.
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Chapter 7 Viewing Log Files

7.1.1 Opening a Log File

To open a log file, click on the Open button L= on the PAS toolbar, or select “Open...” from the File menu. In the
“Files of type” box, select “Access Database (*.mdb)”, select a directory where your files are located, point to the
file you want to open, select a desired table on the right pane, and then click Open.

7.1.2 Copying Data

To copy the entire data table or graph, or part of the data, into the Clipboard or into another application such as
Microsoft Excel or Word:

1. Click on the data window with the right mouse
button and choose Select All, or, if your current
view represents a table, click on the upper-left
corner of the table (where the “No.” label is
commonly displayed).

2. Click with the right mouse button on the window
again and choose Copy, or click on the Copy
button on the PAS toolbar.

3. Run the application to which you want to copy
data, position the cursor at the correct place, and

then click the Paste button EZ on the
application's toolbar or select Paste from the Edit
menu.

7.1.3 Saving Data to a File

To save data to a file, click on the Save button = _ select a directory where you want your log file to be stored,

select a database or type the name for a new database, and then click Save. To avoid confusion, do not store data
files into the “Sites” directory where site databases are located.

7.1.4 Printing Reports

To print a data report to a printer, click on the print button = on the toolbar, select a printer and click OK. If you
want to check how your document appears on the printed page, select Print Preview from the File menu.

7.1.5 Customizing Views

Date Order

To change the way PAS displays the date, select Options from the Tools menu, click on the Preferences tab, select
the preferred date order, and then click OK.

Timestamp

The timestamp is normally recorded and displayed on the screen at a 1-ms resolution. If you have an application
that does not support this format, you may instruct PAS to drop the milliseconds. To change the way PAS records
and displays the timestamp, select Options from the Tools menu, click on the Preferences tab, select the preferred
timestamp format, and then click OK.

Voltage Disturbance Units

When programming a voltage disturbance trigger in your device, the operate limit for the trigger can be set either in
a percent of the nominal voltage, or in voltage RMS units. To change the disturbance units, select Options from the
Tools menu, click on the Preferences tab, select the preferred units, and then click OK.
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7.2 Viewing the Event Log

Event log files are displayed in a tabular view, one event per row. PAS loads the entire database table to a window,
so that you can scroll through the entire log to view its contents.
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7.2.1 Selecting Primary and Secondary Units

Voltages and currents can be displayed in primary or secondary units. To select units for your data views, click on
the monitor window with the right mouse button, select Options, select the desired units for voltages and currents,
and then click OK.

7.2.2 Filtering and Sorting Events

You can use filtering to find and work with a subset of events that meet the criteria you specify. Click on the Filter

button foe , or click on the report window with the right mouse button and select “Filter...”. Check the causes of
events you want to display, and then click OK. PAS temporary hides rows you do not want displayed.

To change the default sorting order based on the date and time, click on the Sort button gl , or click on the report
window with the right mouse button and select “Sort...”, check the desired sort order, and then click OK.

7.2.3 Linking to Waveforms and Data Records

If you programmed a setpoints to log setpoints operations to the Event log and the setpoints can trigger the
Waveform or Data recorder, PAS automatically establishes links between the event and other database records
where it finds a relationship with the event. Waveforms recorded at the time of the event are always linked to this
event, even if the waveform was triggered by another source.

The event ID for which PAS finds related data is blue colored. Click on the colored event ID to check a list of the
event links. Click on a list item to move to the related waveform or data log record.
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7.3 Viewing the Power Quality Event Log

IEEE 1159 and EN 50160 PQ log files are displayed in a tabular view, one event per row. The IEEE 1159 PQ log
normally contains both power quality and fault events. By default, the fault events are not displayed in the PQ report
unless you enable them through the event filter (see below).
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7.3.1 Selecting Primary and Secondary Units

Voltages and currents can be displayed in primary or secondary units. To select units for your report, click
on the report window with the right mouse button, select Options, select the desired units for voltages and
currents, and then click OK.

7.3.2 Filtering and Sorting Events

To filter events, click on the Filter button F , or click on the report window with the right mouse button
and select “Filter...”, check the categories of events you want to display, and then click OK.

To change the default event sorting order, click on the Sort button 24, or click on the report window with
the right mouse button and select “Sort...”, check the desired sort order, and then click OK.
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7.3.3 Linking to Waveforms and Data Records

PQ events for which PAS finds related links are blue colored. Click on the colored event ID to check a list
of the event links. Click on a list item to move to the related waveform or data log records. Data log records
associated with the event are taken into a separate window for easy viewing and trending.

7.3.4 Retrieving Waveforms Online

If you programmed the PQ recorder to record waveforms on power quality events, you can upload the
waveforms related to a specific event online if they have not yet been retrieved and stored to the database
on your PC. Events for which PAS did not find a corresponding waveform in the database are still black
colored. Click on the event ID, click on the “Retrieve Waveform” prompt, and then point to a database to
which you want the waveform to be stored.

7.3.5 Viewing the ITI (CBEMA) Curve

Impulsive transients and short-duration voltage variations (sags and swells) can be viewed as
magnitude/duration pairs on the ITIC (the Information Technology Industry Council, formerly CBEMA)
curve chart. To view an I'TI curve chart, click on the “ITI” button on the window toolbar.

To view the event details, click on the event point with the left mouse button. To directly move to the
related power quality report entry or to a waveform record, click on the corresponding list item with the left
mouse button.

Power Analysis Software_Getting Started 28



Chapter 7 Viewing Log Files Viewing EN50160 Compliance
Report and Online statistics report

T R

IR TE LD ki ikl
TRTE LP T i 8 1|
URSTN LD e T
FSATE 1 1 P
[ ()

IRTR 0 Rl
BTN LT e Lt
VAT LT B L
PR ] ——
TR T ———
(L NERIS =
(LRSI
IR ] .
[
VT T I R
P A R
[T} (LT L =TT
[TEISERT T ETRT o
T AR
BT

:.
¥
¥
Ll
L
K.
I
¥
F
K
|
K
=
|
K
E
E
t J

7.4 Viewing EN50160 Compliance Report and Online statistics
report

To get the EN50160 Compliance report, select “EN50160 Compliance Statistics” from the Reports menu,
point to the database where you stored the retrieved statistics data, uncheck the voltage characteristics’
tables you do not want to be reported, and then click Open.
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The example of EN50160 Compliance report see in the manual of corresponded meter.
The standard compliance statistics is reported within the selected time range.

For characteristics provided with definite limits, the report shows a percentage of the
observation time within which the characteristic complied with the standard, e.g. 98% of the
observations in selected time range.

For voltage characteristics provided with indicative values, the report gives statistical data
classified by voltage magnitude and duration.
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To change the time range or contents of the report, click on the report with the right mouse
button, select “"Options...”, select the required time range, check the voltage characteristics to
be included in the report, and then click OK.

—From To

I B/21/2008 v| I ¥ 272006 v|

v EMS0160 - Flicker

v EMS0160 - Harmonic Yoltage
EMS0160 - Interharmonic Yoltage
EMS0160 - Power Frequency
EMS0160 - Rapid Yoltage Changes
EMS0160 - Temporary Overvoltages
EMS0160 - Transient Owervoltages
EMS0160 - Yalkage Dips

EMS0160 - Yolkage Interruptions
v EMS0160 - Volkage Unbalance

v EMS0160 - Yoltage Yariations
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If you retrieved the EN50160 online statistics data, you can view the online report on the last retrieved
statistics in the same manner as the EN50160 Compliance statistics report. Select “EN50160 Online
Statistics” from the Reports menu, point to the database where you stored the retrieved online statistics,
uncheck the voltage characteristics’ tables that you do not want to be reported, and then click Open.

7.5 Viewing the Data L

Data log files can be displayed in a tabular view, one data record per row, or in a graphical view as a data trend

graph.
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7.5.1 Viewing Data Trend

To view data in a graphical form, click on the Data Trend IE button on the local toolbar.

To change the time range for your graph, click on the Time Range button on the local toolbar, and then select
the desired date and time range.

7.5.2 Selecting Channels

To select desired data channels for your trend, click on the trend window with the right mouse button, select
“Channels”, check the channels you want displayed, and then click OK.

7.5.3 Customizing Line Colors and Styles

Trend lines for different channels can be shown in different colors using different line styles. To change the colors
or line styles, click on the trend window with the right mouse button, select “Options...”, click on the “Display” tab,
adjust colors and styles for channels, and then click OK. You can also change the colors for the background and
gridlines.
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7.5.4 Using the Marker Lines

The trend window has two blue dashed marker lines. The left marker indicates the starting position and the right
marker indicates the end position for calculating the average and peak values.
To change the marker position, click on the trend window with the right mouse button, select Set Marker, or click

on the = button on the window toolbar, and then click with left mouse button on the point where you want to put
the marker. You can also drag both markers with the mouse, or use the right and left arrow keys on your keyboard
to change the marker position (click on the trend pane with the mouse before using the keyboard, to allow the
keyboard to receive your input).

7.5.5 Using a Zoom

You can use a horizontal and a vertical zoom to change size of your graph. Use the 4 4 buttons on you local
toolbar representing green arrowheads to zoom in and zoom out. One click gives you a 100-percent horizontal
zoom. Two buttons 'E'l 'El representing magnifying glasses give you a proportional zoom in both directions.

7.5.6 Delta Measurements

To measure the distance between two trend points, click on the Delta button i , then click on the first point, and
then click on the second point. The first reference point is still frozen until you close and reopen Delta, while the
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second point can be placed anywhere within the trend line. You can measure a delta in both directions. To disable
delta measurements, click on the Delta button once again.

7.6 Viewing Waveforms

Waveform data can be displayed in five different views. When you open a new file, PAS shows you a waveform
graph showing non-overlapped waveforms. Each waveform window has a local toolbar from where you can open
another window to examine the waveform in a different view.

o

T e Ty [ ol

TR T TR

You can open all five views together to analyze different properties of the waveform like a wave shape, waveform
disturbance, unbalance, or spectrum. When you move to another waveform record, all views are updated
simultaneously to reflect the changes.

To view overlaired waveforms, click on the - button on the local toolbar; to view non-overlapped waveforms,

click on the button.
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Waveform data is recorded in series that may contain many cycles of the sampled waveform. A waveform window

displays up to 128 waveform cycles. If the waveform contains more cycles, the scroll bar appears under the
waveform pane allowing you to scroll through the entire waveform.

7.6.1 Viewing an RMS Plot

PAS can show you a cycle-by-cycle RMS plot of the sampled AC waveforms. To open the RMS view, click on the
Ii button. The graph shows the RMS points updated each half cycle.
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7.6.2 Viewing a Frequency Plot
To view a cycle-by-cycle frequency plot of the sampled voltage waveforms, click on the HZ putton.

7.6.3 Viewing a Spectrum Chart

Click on the |lw. button to view a spectrum chart for the selected waveform channel. To change a channel, click on

the window with the right mouse button, select “Channels...”, check the channel you want displayed, and then click
OK. PAS provides voltage, current, active power and reactive power spectrum charts.

A spectrum is calculated over four cycles of the waveform beginning from the point where the left marker line is

located in the open waveform view. If both waveform views are open, PAS gives the priority to the overlapped
waveform view.
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The order of the highest displayed harmonic component is equal to the half sampling rate at which the waveforms

are sampled minus one. If the waveform was sampled at a rate of 256 samples per cycle, 63 harmonics are

available. With 32 samples per cycle, only 15 harmonics are calculated, while others will be zeros.

PAS can give you indication on whether harmonic levels in the sampled waveforms exceed compliance limits
defined by the power quality standards or local regulations.

To review or change harmonic limits:

1. Click on the spectrum window with the right
mouse button and select “Limits...”.

2. Select a harmonics standard, or select “Custom”
and specify your own harmonic limits.

3. Check the Enabled box to visualize harmonic
faults on the spectrum graph and in harmonic
tables.

Harmonics that exceed selected compliance levels are colored in red on the graph and in the tables.
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7.6.4 Viewing a Spectrum Table

Click on the [ putton on the local toolbar to display the harmonics spectrum in a tabular view for a selected phase
or for all phases together.

The spectrum table shows voltage, current, active power and reactive power harmonic components both in percent
of the fundamental and in natural units, and harmonic phase angles.
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To change a phase, click on the window with the right mouse button, select “Options...”, check the phase you want
displayed, and then click OK.
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7.6.5 Waveform Options

Scrolling through Waveforms
The status bar at the bottom of the window shows you how many records the log file contains. Use green
arrowheads 4 4 B Pl on the window toolbar to scroll through records.

Selecting Waveform Channels

A single waveform record may contain up to 56 waveforms including AC, VDC, digital and analog input channels,
which can be displayed all together in a non-overlapped waveform view.
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To select the channels you want to view on the screen, click on the waveform window with the right mouse button,
select “Channels...”, check the channels you want displayed, and then click OK.

Checkboxes for channels that are not present in the waveform are dimmed.
Selecting the Time Axis

The horizontal axis can be displayed either in absolute time with date and time stamps, or in milliseconds relatively
to the beginning of a waveform. To change the time units, click on the waveform window with the right mouse button,
select “Options...”, click on the “Axes” tab, select the desired units, and then click OK.

Customizing Line Colors and Styles

Channel waveforms are displayed using different colors and line styles. To change the colors or line styles, click on
the waveform window with the right mouse button, select “Options...”, click on the Display tab, adjust colors and
styles, and then click OK. You can also change the waveform background and gridlines color.
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Viewing Phasor Diagrams

The phasor diagrams show you the relative magnitudes and angles of the three-phase voltage and current
fundamental component. All angles are shown relative to the reference voltage channel.
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To change the reference channel, click on the waveform window with the right mouse button, select
“Options...”, click on the “Phasor” tab, check the channel you want to make a reference channel, and then
click “OK”.
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If you leave the Triangle box checked, PAS connects the ends of the voltage and current vectors showing you three-
phase voltage and current triangles. This is useful when analyzing voltage and current unbalances.

Phasor diagrams are calculated over one waveform cycle pointed to by the left marker line. As you move the marker,
the phasor diagrams are updated reflecting the new marker position.

Viewing Symmetrical Components

Waveform views have an additional pane at the right where PAS displays the symmetrical components for voltages
and currents, calculated for the point indicated by the left marker line. To enable or disable the symmetrical
components, click on the waveform window with the right mouse button, select “Options...”, check or uncheck the
“Symmetrical components” box on the “Channels” tab, and then click OK.
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Selecting Primary and Secondary Units

Voltages and currents can be displayed in primary or secondary units. To select units for your waveforms, click on
the waveform window with the right mouse button, select “Options...”, select the desired units for voltages and
currents on the Channels tab, and then click OK.

Using the Marker Lines

Waveform and RMS panes have two blue dashed marker lines. The left marker indicates the position from where
data is taken to calculate the harmonics spectrum and phasor diagrams, and also as the starting position for
calculating the RMS, average and peak values. The right marker indicates the end position for calculating the RMS,
average and peak values. The minimum distance between the two markers is exactly one cycle.

To change the marker position, click on the HL putton, or click on the waveform window with the right mouse button
and select Set Marker, and then click on the point where you want to put the marker. You can drag both markers
with the mouse, or use the right and left arrow keys on your keyboard to change the marker position. Click on the
waveform pane to allow the keyboard to get your input before using the keyboard.

Using a Zoom

You can use a horizontal and a vertical zoom to change size of your waveforms. Use the buttons # : 4 b4
on you local toolbar representing green arrowheads to zoom in or out of the waveform graph. Every click on these
buttons gives you a 100-percent horizontal or 50-percent vertical zoom. Two buttons [ORRCY give you a
proportional zoom in both directions.

When in the overlapped waveform view, you can zoom in on a selected waveform region. Click on the waveform
window with the right mouse button, click 'Zoom', point onto one of the corners of the region you want to zoom in,
press and hold the left mouse button, then point to another corner of the selected region and release the mouse
button.

Delta Measurements

To measure the distance between two waveform points, click on the Delta button Fi , then click on one point, and
then click on the second point. The first reference point is still frozen until you close and reopen Delta, while the
second point can be placed anywhere within the waveform line. You can measure a delta in both directions. To
disable the Delta, click on the Delta button once again.

7.7 \Viewing Synchronized Waveforms

If you have a number of devices with synchronized clocks, you can view waveforms recorded at different locations
in one window. PAS can synchronize the time axes for different waveforms so they could be displayed in a single
plot.

To get synchronized waveforms:

1. Putthe databases with waveforms into the same
folder, or put the sites from which you uploaded
data to the same group in the sites tree.

2. Open a waveform you want to synchronize with
other waveforms, and then click on the Multi-site

<0
View button®. PAS searches for time-
coordinated waveforms that have the same time
span as your selected waveform.
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4. Click on the “Channels” button and select
channels for each site.

5. Click OK.

To change the channels, click on the waveform window with the right mouse button and select
“Channels...”.

7.8 Viewing additional logs and reports

Viewing in PAS some additional logs and reports: Fault Log, Sequence-of-Events Log,

IEEE 1159 Statistics Report see in manual of corresponded meter..
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